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SECTION 1 -  INTRODUCTION 

SOFTWARE DESCRIPTION 

 
The Timberline data acquisition software is designed for use with the TL-2900 ammonia and nitrate dual 
channel analyzer and Cetac ASX-520 or ASX-260 autosampler. This software provides autosampler 
control and generates quantitative data from the ammonia analyzer's 14-bit analog to digital signal. It also 
acts as the operations prompt and reports the status of the current analysis. 
 
The software consists of three separate routines: Setup Parameters, Data Acquisition, and Saved Data. 
The acquisition routine collects data from the ammonia analyzer during the autosampler's timed 
sequence and analyzes the collected peaks for height and area. All the data from a sample run can be 
saved and recovered for later viewing and post data processing. Data generated by the software can be 
reviewed directly in a tabular report form, exported to Microsoft Excel, or saved to HTML files for 
portability. 

 



 

 

SECTION 2 -  CETAC INSTALLATION 

ELECTRICAL CONNECTIONS 

 

 
Figure 2-1: Electrical connections on the back of the Cetac autosampler. 

 

1. Connect the 24V supply to the Cetac and plug the other end of the supply into an open 
receptacle. 

2. Connect the serial cable to the port marked COM 1 on the Cetac, connect the other end of the 
cable to the serial port on the back of the TL-2900. Note: COM 1 is recommended. 

3. Press the power button on the back of the Cetac. The Cetac should respond and travel to the 
home position. 



 

 

PNEUMATIC CONNECTIONS & SIPPER INSTALLATION 

 

 
Figure 2-2: Pneumatic connections and sipper installation. 

 
1. Slide the white block with the sipper guide onto the horizontal control arm and secure with the two 

white plastic screws. 
 

2. Loosen the brown plastic screw and slide the sipper down through the sipper guide until it just 
touches the bottom of the wash tube. Tighten the brown screw when complete. 
 

3. Connect the bottom port of your DI water bottle to the wash tube (lower connection). 
 

4. Connect the top overflow connection so that it flows into your main waste line. 
 

DI Water 

Sipper 

To waste 

Sipper Guide 

Brown Screw 

White Screws 



 

 

CETAC CONFIGURATION 

As mentioned earlier, the data acquisition software is designed for use with the Cetac model ASX-510 or 
ASX-260 autosampler. It is important to understand how the autosampler is configured to ensure proper 
operation and function. 
 

 

 
Figure 2-3: Tube positioning in the Cetac autosampler.  

 

CALIBRATION TUBES 

The ten large tubes in the back row of the Cetac autosampler are used for calibration. When filling these 
tubes, the first tube is always a blank and should contain only DI water. The next five are for your 
standards. The standards may be placed in any order. However, increasing or decreasing order is 
recommended. Only two tubes, one blank and one standard, are required for calibration (three or more 
standards are recommended). 

SAMPLE TUBES 

The standard tube racks on the Cetac autosampler hold up to 240 14ml sample tubes for model ASX-510 
or 120 14ml sample tubes for model ASX-260.  

Calibration Tubes: 2-10 

Sample Tubes: 1-240 

Blank Tube 1 



 

 

SECTION 3 -  OPERATION (QUICK STARTUP GUIDE) 

This guide provides a basic overview of the data acquisition software and is intended to get you familiar 
with the software quickly. You should have standards and samples inserted in the Cetac.  

STARTUP 

Run the TL-2900 program located in the program start menu or on the desktop. You are presented with 
the following screen. 

 
Figure 3-1: Cetac COM Port and Test Tube Rack Size input. 

 
1. Using the drop down box of available COM ports, select which COM port on the computer the 

Cetac autosampler has been connected to. Usually this is COM1. See figure 3-1. 
 

2. Using the drop down box of available test tube rack sizes, select the size you are using and click 
'Ok.' The standard rack size is 60, however different racks to house different size tubes can be 
ordered. See figure 3-1. 

 
Note: These startup settings will be remembered and will not need to be entered in the future. To 
change the rack size or COM port select 'Reset Autosampler' from the 'File' menu. This will show 
that same dialogue box as in figure 3-1. 
 
Note: If you are using a USB to Serial adapter the COM port may be a number 5 or above. You may 
check this by looking in the device manager (Right Click 'My Computer' ► Properties ► Hardware 
tab ► Device Manager). 
 

 



 

 

SETTING UP PARAMETERS 

 
 

Figure 3-2: Setup Parameters Tab – Calibration. 
 

1. Optionally enter any comments in the run information section. 
 

2. Set the 'Post Attenuation' based on the largest calibration concentration. 
 

3. In the 'Calibration' sub-tab select the number of calibration tubes you wish to run (including the 
blank tube) and then enter the known concentrations of each of these tubes. Optionally enter 
names for the calibration tubes. 
 

4. Click the 'Zero Cell' button.  
 

You are now ready to run your calibration standards. Alternatively, the calibration standards can be run as 
samples and selected for the calibration in the ‘Saved Data’ tab. 
 



 

 

SETTING THE BUFFER ZERO 

 
1. If the pointers on the ‘Cell Voltage’ scale are is not centered near 0 volts click the ‘Zero Cell’ 

button to the left of the scale  
 

 
 

Figure 3-3: Buffer Zero-Output Voltage. 
 

2. The voltages may need to be zeroed manually if the reagents or gain setting has been changed. 
To do this, click in the ‘Offset DAQ’ fields and adjust the offsets either using the up and down 
arrows on your keyboard or by entering a new offset value. Increasing the offset value will lower 
the voltage reading and decreasing the offset value will increase the voltage reading. When the 
output voltage approaches zero, click the zero cell button. 

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

RUNNING A CALIBRATION 

1. Check that the 'Cell Voltage' displays are near zero. If not, hit 'Zero Cell' and allow the system to 
be zeroed. 

2. In the 'Calibration' sub-tab click the 'Start Calibration Run' button to commence data acquisition. 
The data collection screen will appear. See figure 3-4. 

 

 
 

Figure 3-4: Data Collection Screen. 
 

 
 
Note: Calibration starts with the blank tube in the back row and sequences through the adjacent 
tubes. 
 
 



 

 

3. Once the data collection has completed the 'Setup Parameters' tab is again shown. 'Ammonia 
Calibrated' and ‘Nitrate Calibrated’ are now checked, indicating that the system has valid 
calibration curves. 

 
4. To view the data, switch to the 'Saved Data' tab. Here the peaks from all tubes that have been 

run can be viewed. The square markers on the peaks indicate the maximum height and the round 
markers show the integration time points for each peak area. The peak height and area is 
displayed above each peak. The same height and area information can be found in the results 
table.  

 
5. To view the calibration curves select 'View Calibration Curve' from the 'Edit' menu. 
 

6. You may toggle between a linear regression data fit or second order polynomial data fit (if three or 
more calibration points are collected). The equations and R

2
 values for the data fit are also 

displayed. Click 'Continue' to return to the Saved Data screen. See figure 3-5. 

 

 
 

Figure 3-5: Calibration Curve Window. 

 



 

 

RUNNING SAMPLE TUBES 

1. Check that the 'Cell Voltage' display is near zero. If not, hit 'Zero Cell' and allow the system to be 
zeroed. 

 
2. Set the 'Sample Tubes to Run', 'Start at Tube' and 'Runs Per Tube' controls and optionally enter 

names for the sample tubes. Sample tube names can also be loaded from a CSV file using the 
File menu. See Figure 3-6.  

 

 
 

Figure 3-6: Setup Parameters Tab – Sample. 
 
 

3. Click 'Start Sample Run' to commence data collection. The data collection screen will appear. 
 



 

 

4. When data collection is complete you are returned to the 'Setup Parameters' screen. You can see 
the data just collected by switching to the 'Saved Data' tab. 

 

 
 

Figure 3-7: Saved Data Tab. 
 

5. The newest peaks are on the right of the plot and their information presented at the top of the 
table. See figure 3-7. 

 



 

 

RUNNING SAMPLES FOR NITRATE 

 

 
 

Figure 3-8: Nitrate Runs Setup Parameter. 
 

The nitrate offset parameter adjusts the integration time points to account for the increase in sample time 
when the sample passes through the reduction cartridge. This is dependent on pump speed and tubing.  
Before running any samples for nitrate, you must determine the nitrate offset time.  
 

1. Place a standard in the first sample position of the autosampler. 
 
2. Set the Nitrate Offset Time to 00:00. Switch to the Sample tab and set 'Sample Tubes to Run' to 1 

and 'Start at Tube' to 1. Click 'Start Sample Run' to begin data acquisition.  
 

3. When data collection has completed switch to the Save Data tab. The green plot is the ammonia 
peak and the red plot is the ammonia + nitrate peak. 

 



 

 

 

 
 

Figure 3-910: Nitrate Run Results. 
 

 
4. You want to look at the point where each peak just starts to rise from the baseline. In this 

example, the time is 1:05 for the ammonia peak and 1:20 for the total nitrate peak. See figure 3-9. 
If you subtract the times, the Nitrate Offset Time is 15 seconds. You can now enter 0:15 into the 
'Nitrate Offset Time' field on the setup parameters screen.  
 

5. Now your ammonia + nitrate area calculation will start at the same place as your ammonia peak. 



 

 

RUNNING SAMPLES WITH PIPELINED INJECTIONS 

Running samples with pipelined injections significantly reduces analysis time but also requires a few more 
parameters.  

To set the 'Wait time for first peak' and 'Wash Time' parameters you must find out how long sample takes 
to reach the conductivity cell, which is dependent on pump speed and tubing. Place a standard in the first 
sample position of the autosampler. 

1. Un-check Pipeline Autosampler Injections.  

2. Switch to the Sample tab and set 'Sample Tubes to Run' to 1 and 'Start at Tube' to 1. Click 'Start 
Sample Run' to begin data acquisition. 

 

 

Figure 3-10: Pipelined Injection Runs Setup. 

 

3. When data collection has completed switch to the Save Data tab. You want to look at where the 
ammonia peak just starts to rise above the baseline and where the nitrate returns back to the 
baseline. In this example this is at 1:05 and 2:30. 

4. From this you get a 'Wait time for first peak' value of 1:05. If you subtract the two times we get a 
'Wash Time' of 1:25. You can now enter 1:05 into the 'Wait time for first peak' field on the setup 
parameters screen once you have enabled 'Pipeline Autosampler Injections' and entered 1:25 
into the 'Wash Time' field. 

 



 

 

MANAGING YOUR SAVED RESULTS 

 
Figure 3-11: Saved Data Tab. 

 

VIEW AND ANALYSIS OPTIONS 

1. The number of peaks shown on the plot graph can be changed using the ''View Runs' box at the 
top of the screen. To display a single peak, enter the run number in the box next to 'View Runs'. 
To view multiple, consecutive peaks, enter the lowest run number and the highest run number 
you want to see and separate the two numbers by a hyphen (i.e. 22-27). To display multiple, non-
consecutive peaks, enter the run numbers into the box and separate each run number by a 
comma.  
 

2. Peaks can be analyzed using peak height or peak area which is toggled by the 'Analyze Peaks 
Using' radio buttons. Peak height simply finds the highest point on the peak. Peak area finds the 
area of the peak between the start and stop integration markers. 
 

3. The concentrations of sample tubes can be calculated using either a linear data curve fit or a 2
nd
 

order polynomial data fit if three or more calibration tubes were used to calibrate the instrument. 
This is toggled with the 'Calculate Concentrations Using' radio buttons. 
 

REMOVING UNWANTED RUNS 

Unwanted tube data can be removed using the 'Delete Selected Row' item in the 'Edit' menu. First click 
the row in the results table you want to remove from memory. Select 'Delete Selected Row.' The row is 
removed from the table and its corresponding peak is also removed from the graph. 
 
Note: Once a row is removed it cannot be recovered, so be careful to remove the right row. 



 

 

SUMMARY REPORTS 

Summary reports combine all the run information shown on the 'Saved Data' screen into an easy to read 
format. These reports are ideal for emailing and printing. The summary reports include the following: 
 

• Timing information for the runs 

• Calibration curves, equations, and R2
 values 

• A combined peak plot showing all peaks together 

• Individual peak plot pages broken up as defined by the user 

• Results tables for each peak plot page 
 

1. Select either 'Print...' or 'Save as HTML...' from the 'File' menu. 
 

2. Configure the report pages and analysis options and click 'Ok.' 
 

3. Either a print or save dialog is displayed to complete the operation. 
 

4. A report can also be printed directly from the 'Saved Data' screen by hitting the 'Print Report' 
button in the 'Load Data From' box. 
 

5. Configure the report pages and analysis options and hit 'Print'. 
 

SAVING RUN DATA 

All stored run data can be saved to a Timberline Data File (*.tdf) for later viewing and creation of summary 
reports. 
 

1. Remove any runs you do not want to be stored in the file. 
 

2. Select 'Save...' from the 'File' menu.  
 

3. A save file dialog box appears. Type in a file name, select a location to save to, and click 'Save.' 

LOADING RUN DATA 

Previously saved data files can be loaded again for viewing. 
 

1. Click the 'Load Data From File' radio button. A file path indicator and open file button appears. 
 

2. Click the open file button. An open file dialog box appears. 
 

3. Locate the file you wish to open and click ‘Open’. 
 

4. The current run data is replaced by the stored information. Summary reports can be printed and 
saved, unwanted runs can be removed as before, tube name and comments can be changed, 
and the modified data can be saved again to a data file. 
 

5. When you are done viewing, modifying, and creating new data files click the 'Load Data From 
Current Runs' radio button and the current runs are restored to the screen. 

 

SAVING YOUR SETTINGS (CREATING A METHOD) 

Note: Methods can only be created and loaded from the 'Setup Parameters' tab only. 
 
If you are satisfied with the settings, save them as a method by selecting the 'Save Setup Parameters to 
Method File' in the 'File' menu in the setup parameters tab. You can now shutdown and restart the 
program and easily load all your settings. For a further description of managing methods see section 4. 



 

 

SECTION 4 -  OPERATING MODES 

GENERAL SETUP PARAMETERS 

The setup parameters screen is where all parameters are defined to control the data acquisition. This 
screen includes sections to name your runs, set up timing parameters, select the number of tubes to run, 
and create unique sample IDs. 

 

RUN INFORMATION 

Field Description 

Pump Speed Allows you to record the pump speed. 

Pump Revolutions Allows you to record the number of revolutions this pump has made, a good way 
to check for wear of tubing. 

Cell S/N Allows you to record the cell serial number. 

Membrane S/N Allows you to record the membrane serial number. 

Buffer Concentration Allows you to record the buffer concentration. 

Buffer Recycle A drop-down box to record whether the buffer is recycled or put to waste. 

Caustic 
Concentration 

Allows you to record the caustic concentration. 

Caustic Recycle A drop-down box to record whether the caustic is recycled or put to waste. 

Comment Box Allows for any other comments. 

Pump Setpoint Sets the speed of the pump. 

 

TIMING PARAMETERS 

Field Description 

Injection Time Determines the amount of time (in min:sec format) sample is drawn from each 
tube. 

Wash Time Determines the amount of time (in min:sec format) DI Water is drawn from the 
wash station before advancing to the next sample tube. 

Integration Start 
Time 

Defines when the peak area calculation begins. 

Integration End Time Defines when the peak area calculation ends. 

Nitrate Offset Time Since it takes longer for the sample to travel through the nitrate reduction 
cartridge, this control allows the area integration calculation to be delayed by the 
specified amount of time. 

 



 

 

OPTIONS 

Field Description 

Turn Pump Off at 
End of Run 

When enabled, the system automatically turns off the peristaltic pump at the end 
of the analysis. 

Pipeline Autosampler 
Injections 

When enabled, the system injects the next sample ahead of time to significantly 
reduce analysis time. See Pipelined Runs Section for further description of this run 
mode. 

Extend Wash Time When enabled, the system automatically extends the wash time based on peak 
height and the value n you enter into the box. Extending the wash time 1 second 
for every 1 * n unit of conductivity. The value entered typically ranges from 10 to 
200. Not available when running in pipelined injection mode. 

Zero Cell Zeros the cells when depressed. 

Offset DAQ 1 Displays the amount of offset voltage required to zero the cell in channel 1. 

Offset DAQ 2 Displays the amount of offset voltage required to zero the cell in channel 2. 

Front Panel Gain 
Setting 

Allows you to record the gain setting selected on the front panel. 

Post Attenuation Signal is attenuated by a factor of 8, 4, 2, or 1. User selectable 

Cell Voltage Displays the cell voltages for the user.  

 

EXAMPLE OF HOW SENSITIVITY, GAIN AND POST ATTENUATION AFFECT THE OUTPUT SIGNAL: 

Highest Sensitivity: Gain=1000, Attenuation=1, the output signal is amplified by a factor of 1000 
Lowest Sensitivity: Gain=1, Attenuation=8, the output signal is amplified by a factor of 0.125 
 

CALIBRATION AND SAMPLE TABS 

Field Description 

Start Calibration / 
Sample Run 

Once you are satisfied with your Setup Parameters click this button to launch data 
acquisition on the selected tubes. 

Calibration / Sample 
Tubes to Run 

The total number of tubes to be included in the run. 

Start at Tube Starts the run beginning with the tube indicated in this field. Only available for 
sample runs. Calibration runs always begin with blank cal tube number 1. 

Runs Per Tube Allows multiple samples of each tube to be injected. Only available for sample 
runs. 

Calibration Status Displays a check mark if the system has a valid ammonia and total nitrate 
calibration curve in memory. 

Calibration Tube 
Concentrations and 
Names 

This table is for entering the known concentrations for each of the calibration tubes 
to be run and optionally the names for the tubes. If you are running just an 
ammonia calibration, concentrations need only be entered for the column. 
Concentrations must be entered in both the 'NH3 conc.' and 'NO3 + NH3 columns. 

 



 

 

MENU ITEMS 

 

Figure 4-1: Setup Parameters Tab – File Menu 
 

File Description 

Save Setup Parameters 
To Method File 

Brings up a save file dialog which allows you to save all parameters on the 
'Setup Parameters' tab to a method file. 

Load Setup Parameters 
From Method File 

Brings up a load file dialog which allows you to load all parameters on the 
'Setup Parameters' tab with values from a method file. 

Load Calibration Tube 
Names & Concentrations 
From CSV File 

Brings up a load file dialog which allows you to load the calibration tube 
names, ammonia, and total nitrate concentrations from a stored CSV file. See 
the next section on creating tube name CSV files. 

Load Sample Tube 
Names From CSV File 

Brings up a load file dialog which allows you to load the sample tube names 
from a stored CSV file. 

Reset Autosampler Resets the Autosampler to home. 

Exit Exits the program. 



 

 

TUBE NAME CSV FILES 

Tube names give an identifier to each sample for easy recognition. Tube names and concentrations for 
calibration tubes can be loaded from an external CSV file or entered directly into the table. 
 

 

Figure 4-2: Creating Tube Name CSV files for Samples (left) Calibration (right). 
 

 
Figure 4-3: Calc Export of text files (left) and resulting CSV File (right). 

 
1. Open a blank spreadsheet and enter the sample tube numbers in Column A, rows 1 up to 9 for 

calibration tubes and rows 1 up to 120 or 240 for sample tubes. 
 

2. For Calibration tubes enter the known ammonia concentrations in Column B, and total nitrate 
concentrations in Column C. 
 

3. Save this file as a 'Text CSV (.csv)' file. Answer yes to the format warning to save as a Text CSV 
file. Make sure the Field delimiter is a comma and there is no text delimiter. See figure 4-4. 
 

4. This file can now be loaded in the program. 



 

 

METHODS 

Methods are a quick way to save and load all your settings as well as your tube names. Individual 
methods for various analytical techniques can be created and saved for future use. 

CREATING 

All of the parameters shown in the setup screen are saved in a method. Once you are satisfied with your 
settings you may create the method by selecting 'Save Setup Parameters To Method File' in the file 
menu. Enter a new file name for the method and click 'Save'. 

LOADING 

To load a previously created method, select 'Load Setup Parameters From Method File' in the File menu. 
Then in the load file dialog, select a method file, and click 'Open'. 

UPDATING 

To save any changes you have made to the current method. Select 'Save Setup Parameters To Method 
File' in the file menu.  
 
Note: Tube names are saved in methods. However, changes to the tube names are not saved back 
to the CSV file. 
 



 

 

DATA ACQUISITION MODE 

This screen displays peak data as it is being collected. The fields below show the status of the current 
analysis. The data acquisition process can be canceled any time after autozeroing. 
 

 

Figure 4-4: Acquisition Mode screen. 

FIELD DESCRIPTIONS 

Field Description 

Conductivity Plot Displays the conductivity of the fluid passing through the cell in real-time. 

Autoscale Y Axis Enabling this option will automatically set the Y scale to -0.001 to 0.05 at the 
beginning of each tube to show the stability of the baseline. As the sample peak 
rises, the scale increases to adjust for the peak height. Disable this option if you 
want to fix the Y scale at your own range. 

Graph Tools 
(Hand, Magnifying 
glass, Cross-hairs) 

These tools allow you to manipulate the conductivity plot. The hand tool pans the 
graph when you click and drag. The magnifying glass contains different zoom 
options: Zoom to Rectangle, X-zoom, Y-zoom, Zoom In about Point, Zoom Out 
about Point, and Zoom to Fit. The final cross-hair tool is unused here. 

Previous Results Data from completed tubes is displayed here. You may edit tube names and 
comments here and any changes will be carried through to the Saved Data tab. 

CH 1 Reading and 
CH 2 Reading 

The actual voltage from the acquisition hardware.  

Sample Rate The actual rate at which conductivity measurements are taken. If this value is 
fluctuating you may have too many programs open or insufficient computer speed to 
run the Timberline Data Acquisition Software. 

Time Left Displays how much time is left on the current tube. 

Cancel Run Stops the Data Acquisition process. The data from the current tube is not saved. 

 

CANCELING A RUN 

To cancel a run click the 'Cancel Run' button. The Cetac will immediately return to the home position and 
the Setup Parameters screen will be displayed. All data from tubes finished before the run was canceled 
is saved. You may need to wait for the TL-2900 output to return to the baseline before running additional 
samples. 



 

 

SAVED DATA 

The saved data tab allows you to view saved run information. Here information can be printed or saved 
as a summary report. 
 

 
Figure 4-5: Report Preview Window. 

 
 

Field Description 

Load Data From Allows you to switch between displaying data from the current set of runs and 
runs in a stored data file. When loading from a data file, click the 'File' radio 
button, click the open file button that appears, select the file you wish to load 
from the open file dialog and click 'Open.' 

Clear All Current Runs 
Data 

Clears all the current runs from memory, leaving the calibration curve intact. 
Make sure you save your data to a data file before using this control because 
data cannot be recovered once it is cleared. 

Print Report Allows you to print a report straight from the Saved Data page. 

View Runs Shows the run numbers of the peaks that are being displayed in the window out 
of the total number of runs. 

Analyze Peaks Using Allows you to switch the type of peak analysis between peak height and peak 
area between the integration markers. 

Calculate 
Concentrations Using 

Allows you to switch the calibration curve used to calculate concentration 
between a linear data fit and a second order polynomial data fit. 

Timing Parameters Shows the timing parameters on the currently selected row. 

Results Table Displays analysis information on all samples run. You can edit tube names and 
comments here as well. Clicking a row allows you to change what sample(s) are 
shown in the plot. 

 
 


